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Introduction 
Functional Mockup Interface (FMI) is a tool independent standard to support both model exchange and 

co-simulation of dynamic models. This workshop provides hands-on experience with FMI-based 

workflows in a sample of FMI-compliant tools including the following: 

• FMU export from Dymola 

• FMU import and simulation in Dymola 

• FMU import and simulation in PyFMI 

• FMU import and simulation with FMI Add-in for Excel 

• FMU import and simulation with FMI Toolbox for MATLAB/Simulink 

• FMU export from Simulink with FMI Toolbox for MATLAB/Simulink 

The goal of this workshop is to illustrate the creation and use of FMUs in several different tools.  While 

only a sampling of available FMI-compliant tools, this workshop aims to demonstrate the power and 

flexibility of FMI-based workflows for CAE toolchain integration.  The tools above are provided as part 

of the material distributed with this workshop along with evaluation licenses as required. 
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Model Overview 
The dynamic model used throughout this tutoria is a Vehicle Thermal Management (VTM) system model 

for studying vehicle-level interactions between thermal management systems.  This particular example is a 

conventional four wheel passenger sedan chassis and drivetrain architecture with a spark ignition engine 

and standard transmission.   These mechanical systems are created using components from the Vehicle 

Dynamics Library (VDL) from Modelon.  The model also includes a representation of the coolant and oil 

fluid loops for the engine and transmission in conjunction with a four heat exchanger stack for the thermal 

domain.  These portions of the model are constructed from components of the Liquid Cooling Library 

(LCL) from Modelon.   A snapshot of the entire system is shown in the following figure. 

 

Figure 1 Complete system model 

Model SystemsModel SystemsModel SystemsModel Systems    

The key systems within the model are: 

• Thermal Management 

o Lumped engine thermal mass 

o Lumped transmission thermal mass 

o Engine coolant fluid circuit 

o Transmission oil cooling circuit 

o Grill shutters and controller 

o Heat exchanger stack 

• Mechanical/Electrical/Driver 

o Driver 
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o Vehicle 

� Engine 

� Transmission 

� Driveline 

� Chassis 

� Aerodynamics  

� Other external loads 

� Brakes 

o Low voltage battery 

o Alternator 

o Cooling fan and controller 

Model FeaturesModel FeaturesModel FeaturesModel Features    

The key features of these systems are: 

• Driver  

o closed loop speed control for drive cycle following with automatic gear shifting 

o Standard list of drive cycles 

• Vehicle – Engine  

o Torque map from throttle and speed with heat generation 

• Vehicle – Transmission 

o Standard transmission with efficiency losses for heat generation 

• Vehicle – Driveline 

o Rear wheel drive with parameterized final drive ratio 

• Vehicle – Chassis  

o VDL compatible interfaces 

o 1D longitudinal dynamics 

o Ideal suspension and wheels 

• Fluid coolant circuits 

o Heat transfer pathways with thermal masses 

o Crankshaft pump loads 

o Thermostat fluid control 

o Fluid flow resistances 

• Heat exchanger stack 

o Parameterized geometry, efficiency, resistances 

o Stack ordering effects 

o Air flow effects  due to vehicle speed, grill position, and fan speed 

• Alternator  

o Crankshaft load 

• Cooling fan and controller 

o Power supplied by alternator 

• Grill shutters and controller 

o Variable position  

o Heat exchanger stack air flow modification 
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o Aerodynamic drag effects 

 

Figure 2 Thermal management system 
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Figure 3 Mechanical, electrical, and driver system 

 

Since the purpose of this model is to study vehicle thermal dynamics, a simplified 1D longitudinal 

dynamics chassis model is used rather than a full 3D body model.  This approach allows for faster 

simulations of the typically long duration drive cycles. 

During the simulation, heat generated by the engine is stored within the engine thermal mass and then 

rejected to the coolant-to-air heat exchanger (radiator) through a coolant fluid loop.  A similar loop and 

heat exchanger also exists for the transmission oil. 

The model is well suited to thermal management controller design, studying tradeoffs between thermal 

management energy demands and fuel economy, heat exchanger efficiency and sizing, and coolant fluid 

flow dynamics. 

For this work, the model was partitioned into separate FMU executables by dividing the model along 

domain boundaries.  In this case, the vehicle mechanics, electrical, and driver were grouped into one 

model while the fluid and thermal portions of the model were grouped into another.  In order to achieve 

this structure, the physical connections that are bisected by the boundaries must be converted to causal 

signals.  As an example for the engine, the heat is generated within the mechanical portion of the model.  
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The heat is directed to the lumped thermal model, within the thermal portion of the model, which 

determines the thermal mass temperature.  Images of these two systems are shown below. 

Key ParametersKey ParametersKey ParametersKey Parameters    

Parameter Path Default 

Value 

Description 

driverVehicle.vehicle.body_mass 1600 kg Overall vehicle mass 

driverVehicle.vehicle.R0_front 0.3 m Front wheel radius 

driverVehicle.vehicle.R0_rear 0.3 m Rear wheel radius 

driverVehicle.vehicle.wheel_i_xx_front 1 kg.m2 Individual front wheel inertia 

driverVehicle.vehicle.wheel_i_xx_rear 1 kg.m2 Individual rear wheel inertia 

driverVehicle.vehicle.driveline.rear_ratio 4 Final drive ratio 

driverVehicle.vehicle.engine.J 0.1 Engine inertia 

driverVehicle.vehicle.transmission.JA 0.04 Transmission engine side inertia 

driverVehicle.vehicle.transmission.JB 0.07 Transmission driveline side inertia 

driverVehicle.vehicle.c_w_front 0.38 Aerodynamic drag coefficient 

driverVehicle.vehicle.a_front 2.7 m2 Vehicle frontal area 

driverVehicle.vehicle.externalLoads.scale 1 Additional drag scale factor 

driverVehicle.vehicle.engine.frictionScale 1.0 Engine friction scale factor 

driverVehicle.vehicle.transmission.frictionScale 1.0 Transmission friction scale factor 

driverVehicle.vehicle.engine.k_tau 1.5 Engine torque scale factor (note does not affect fuel consumption) 

driverVehicle.vehicle.brakes.brake_N.clamp_factor 2 Individual brake clamping factor (for N = wheel number 1 – 4) 

driverVehicle.vehicle.brakes.brake_N.mu 0.3 Individual brake coefficient of friction (for N = wheel number 1 – 4) 

driverVehicle.vehicle.brakes.brake_N.J_disc 0.05 kg.m2 Individual brake inertia (for N = wheel number 1 – 4) 

File Structure 
The tutorial files are organized as shown in Figure 4.  “Licenses” contains evaluation licenses for FMI 

Add-in for Excel and FMI Toolbox for MATLAB/Simulink.  These licenses are good through October 20, 

2014.  The installers for the various software components are in the “Software” folder.  The “Demos” 

folder contains all the relevant files for the tutorials using the different tools with the required FMUs in the 

“FMUs” folder.  Note that the FMUs expire on Nov. 5, 2014.   

 

Figure 4 Tutorial files 

Demonstration: FMU export from Dymola (optional , requires Dymola) 
This tutorial walks through the steps to create both a Model Exchange (ME) and Co-Simulation (CS) 

FMU with Dymola with a sample model from the Modelica Standard Library.  The resulting FMU file 

structure is also explained.  Note that this tutorial is optional as FMUs have already been provided as part 

of the workshop material for import into other tools. 
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1) Go to the Simulation > Setup > FMI dialog in Dymola and change the export properties so that 

Dymola generates Model Exchange FMUs of FMI version 1.0. 

 

2) Press OK to close the dialog 

3) Open Modelica.Mechaniscs.MultiBody.Examples.Elementary.Pendulum from the package 

browser. Then switch to Simulation mode of Dymola. 

4) Click on the little arrow next to the Translate button and select FMU to translate the model into a 

Model Exchange FMU of version 1.0. You may need to force Dymola into generating a 32bit 

FMU in case you are using a 32bit compiler together with 64bit Dymola by selecting the 

appropriate Binaries option from the FMI tab in Simulation Setup. The recommendation is to use 

32bit Dymola if you only have a 32bit compiler installed (free Visual Studio compilers). 64bit 

FMU compilation is possible with Visual Studio 2012 express and newer, older versions of the 

free (express) editions of Visual Studio only support 32 bit.  

 

 
 

Note that Dymola translates the translate action into a command translateModelFMU() and runs it 

from the command prompt. This command can be useful if you want to generate FMUs directly 

from the command line or from Modelica scripts. 

  

 
 

5) Navigate to the folder where the FMU has been generated (your current directory). A file 

Modelica_Mechanics_MultiBody_Examples_Elementary_Pendulum.fmu should be present in the 

folder. 
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6) Unzip the FMU with a standard zip tool. Change the file extension of the file to .zip to use the 

built in zip tool in Windows.  

7) The FMU consists of a modelDescription.xml file and a folder with binaries (compiled model). 

Open the modelDescription.xml and investigate its contents. Rename the file 

“modelexchangeXML.xml” and save it to a separate folder (not to the FMU). 

 

 
8) Go back to Dymola and open the Simulation > Setup > FMI dialog. Change the properties to 

export Co-Simulation FMUs of version 1.0. 

9) Repeat step 2-7 and compare the content of the Co-Simulation XML file with the contents of 

modelexchangeXML.xml. In addition to the information of the Model Exchange XML file, the 

CS XML file also contains a section <Implementation> with some general information about the 

solver at the very end of the file. 

 

 
 

With other programs that can generate and export FMUs, the process is fairly similar even though 

the user interface and details can vary. In every tool, the options are similar as they are governed 

by the standard, and most tools will do the same basic process: they compile the model into an 

executable dll that can be deployed to other CAE platforms.  

Demonstration: FMU import in Dymola (optional , requires Dymola) 
This tutorial walks through the steps to import an FMU into Dymola and simulate. 
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1) In Dymola, change the FMU import type to Co-simulation, and in order to save time for this 

example, disable the import of all variables.  These settings are in the FMI tab of the Simulation 

Setup dialog.  The format of this tab has changed slightly for the later versions of Dymola with the 

inclusion of a couple different options, but in general it should look like the following figure. 

 

Figure 5 Dymola FMU import settings dialog 

2) Import the vehicle model FMU VTMModels_Ideal1DSedanCycleFollower.fmu.  From Dymola, 

click File > Import > FMU and select the FMU from the FMUs\CS directory as shown below. 

 

Figure 6 Dymola FMU file import dialog 

 

 



10 
 

 

Note that the action is translated into the command importFMU()that can also be run from the 

command prompt in Dymola.  

 

Figure 7 Dymola importFMU command 

 

3) Repeat the above two steps to import the thermal management FMU 

VTMModels_SedanThermalManagement.fmu. 

4) The imported FMU models will appear in the Package Browser. 

Note that there are some options that govern the appearance of FMUs after import. In Dymola 2015, if the 

option flag Advanced.FMI.OverlappingIO is set to true, inputs of the same type will be drawn on top of 

one another to improve the graphics for FMUs with many inputs. In Dymola 2015 FD01 this has been 

refined to an integer flag Advanced.FMI.OverlappingIOThreshold that will group signals of the same type 

if there are more of them than the threshold number.  

 

Figure 8 Dymola imported FMU instance 

5) Load the Demos\Dymola\FMUTests Modelica package in Dymola. 
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Figure 9 Dymola closed loop connected FMU model 

The package contains the FMU_CS_BB_CL model with fully connected and parameterized 

instances of the vehicle and thermal management FMUs. 

6) Change to the simulation tab in Dymola and simulate the model.  

7) Generate a figure of the vehicle speed (the variable called vehicle_0v from either the vehicle or 

thermal management model). 
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Figure 10 Dymola vehicle speed trajectory 

Zoom in on a section of the trajectory and observe the signal.  Note that the trajectory appears as a 

series of steps at the same rate as the communication interval set by the top level parameter 

fmi_CommunicationStepSize. 

 

Figure 11 Dymola vehicle speed trajectory zoom 

8) Observe the statistics section of the translation log. Note that it shows there are no continuous 

time states. 
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Figure 12  Dymola translation log 

Demonstration: FMU import and simulation using PyFMI (optional,  

hands-on) 
This tutorial shows the import of FMUs into PyFMI, an open source tool that provides a Python 

environment for FMI.  Note that this tutorial requires the installation of JModelica which was provided as 

part of the tutorial material. 

In this tutorial, we will run a parameter sweep with the vehicle model with inputs for the throttle command 

and the brake force.  In the script, we will construct the inputs for a wide open throttle (WOT) run and 

look at the maximum vehicle speed while varying the final drive ratio. 

1) Preparation: Install JModelica via installer JModelica.org-1.15.exe accepting all defaults. 

2) Navigate to Demos\PyFMI folder for the workshop material in Windows Explorer.  Type cmd in 

the file location field of the Explorer window to start the Windows command prompt in the 

PyFMI directory. 

3) Type the command shown below to set some environment variables that Python needs assuming 

the default installation location for JModelica: 
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4) Execute the script ParameterSweep.py by typing the command shown below assuming the default 

installation location for Python (note that the full path to Python is used here as there is no 

assumption that Python is added to the Windows Path environment variable): 

 
 

5) The simulations will execute and provide feedback in the command window. Once the 

simulations are complete, examine the plots for vehicle speed, gear command, engine speed, and 

engine torque as a function of time for the simulations. A plot is also included that shows the 

maximum vehicle speed as a function of the final drive ratio. Does it make sense to run different 

drive ratios with the same transmission shift control logic?  Why is there a sudden drop in engine 

torque for one of the simulations? 

6) Open the Python script in a text editor and look at the various sections.  The script is commented 

to show the key syntax for defining the sweep parameters, providing the inputs, loading the FMU, 

setting the parameters, simulating the FMU, and extracting the results. 

Optional exercises: 

• Increase the number of points in the sweep to better understand the shape of the max vehicle 

speed vs. final drive curve. 

• Refine the parameter sweep around the maximum vehicle speed to better identify the 

“optimum” final drive ratio (assuming same control strategy, etc.). 

• Investigate 0-60 mph time (~26.8 m/s) by shortening the simulation time.  Does the same 

drive ratio that maximized vehicle speed also give the best 0-60 time? 

• Construct different throttlePostion inputs to simulate different types of drives.   

• Copy the script and modify it to investigate the impact of vehicle mass on max vehicle speed 

and 0-60 time. The vehicle mass parameter is driverVehicle.vehicle.body_mass.    

PyFMI includes a number of different examples of FMI-based workflows including compilation of 

FMUs, different simulations with FMUs, etc. This tutorial is meant to only show the basics for 

loading and simulating an FMU.  More information about PyFMI can be found at 

http://www.jmodelica.org/page/4924.  

Hands-on: FMU import and simulation using FMI Add-in for Excel® 
This tutorial demonstrates an FMI based analysis workflow using Microsoft Excel® and the FMI Add-in 

for Excel® (FMIE) from Modelon.  A demo license of the add-in will be provided as part of this tutorial.  

Note that FMI Add-in for Excel requires 32-bit Microsoft Excel which is the default for most Office 

installations. 

1) Preparation: Install the FMI Add-in for Excel® via installer FMI Add-In for Excel 1.3.3.exe 

accepting all defaults.  This installation will add the FMI entry to the ribbon bar. The demo 

license for FMIE is in the Licenses folder of the demo distribution and should be placed in the 

AppData folder as described in the FMIE User’s Guide (i.e. 
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C:\Users\username\AppData\Roaming\Modelon\Licenses\Nodelocked).  To activate the license, 

perform the following steps: 

• In the FMI Ribbon tab shown below, click on License. 

• Using the drop-down list next to the label Active feature, select “Standard”. 

• Click the button Change... and select "OK" when prompted with a verification question. 

• Restart Excel for the changes to take effect. 

 

Figure 13  FMI Ribbon Tab 

Note that the FMI tab contains different groupings of buttons. Some of the buttons are disabled by 

default. They are enabled when the active sheet contains data in a matching format. 

The following steps document the process used to generate the 

Demos/FMIE/DriveCycleVTM.xlsx Excel® workbook.  The workbook is already available with 

all the FMI related worksheets and simulation results completed.  Interested users can feel free to 

go through the steps separately to investigate the process further.   

2) Start a new workbook in Excel® and click the Load FMU button on the FMI tab to open a File 

Open dialog box.  Browse to the VTMModels_Tests_DriveCycleVTM.fmu file within the 

FMUs/CS folder and click Open.  This FMU is a co-simulation FMU based on the model shown 

in Figure 1. 
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Figure 14  FMU Open Dialog 

3) A new sheet is created with the prefix “FMU” (e.g. FMU Tests.DriveCycleVTM).  There are two 

areas in the new sheet, one for model metadata ("Model") and one for the variables in the FMU 

("Variables"), see Figure 15. The metadata section contains general information about the FMU, 

e.g. model name, FMU kind, number of state variables, etc. The Variables area lists the variables 

with name and their corresponding attributes, including start value, unit, data type, etc. There are 

two columns that do not correspond to any FMI attribute: the "Include" column and the 

"Experiment" column. The Include column indicates if the variable will be included in the 

experiment or not. The Experiment column indicates if a variable will be used as an input or an 

output. 
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Figure 15  FMU Worksheet 

Note that the Create Experiment button in the ribbon was enabled when the FMU sheet was 

created. It is only enabled when the active sheet is an FMU sheet.  Also, by default the FMU path 

field includes the full system path to the FMU.  In this tutorial image the path is shown relative to 

the Excel® working folder.  The working folder can be determined by clicking File � Open.  The 

initial path shown in the Open dialog is the current working folder.  The working folder is 

changed to the folder of files opened by this dialog.  It can often be easiest to keep the FMU paths 

as absolute when not sharing workbooks. For example, if this FMU was placed in a sibling folder 

called FMU relative to the workbook, the relative path would be 

FMU\VTMModels_Tests_DriveCycleVTM.fmu. 

4) The value in the Experiment column indicates whether a variable is included or not in an 

experiment. By default, no variable is included.  Variables will be included by filtering the names 

and setting the Include field to TRUE. 

a. Using the list filter in the Name column search for “driveCycleNameIndex”. 

 

Figure 16  FMIE filtered Name list 
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This step should result in at least one entry found with “parameter” variability.  Select any 

cell in this row and click Add Filter from the FMI tab.  This action will mark the Include 

field of all the variables found with the filter as TRUE. 

 

Figure 17  FMIE toggled variable include flag 

b. Now search for “driveCycleScale” and “rear_ratio” from the Name column and repeat the 

above procedure to include the parameters in the experiment. 

c. Finally some output (“outdata”) variables must also be included in the experiment.  

Search for “summary” in the Name column.  This filter should yield many valid entries.  

Toward the bottom of the list will be the top level summary record entries as shown in the 

following figure. 

 

Figure 18  Filtered summary record variables 

Select all the desired output variables then click the Add Selection button from the FMI 

tab.  This step will mark all the selected variables as included.  Any valid multi-selection 

combination of cells (adjacent or not) will work.  Likewise the Remove Filter and 

Remove Selection buttons can be used to toggle the Include field to FALSE.  Manually 

toggling the Include field is also valid although a bit tedious when selecting many 

variables. 
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Finally verify the included variable list by filtering on the Include column for variables 

marked TRUE.  The list should be similar to the following.  Note that it includes variables 

that are inputs (indata) as well as outputs (outdata). 

 

Figure 19  FMIE included variable list 

5) Now that the desired variables have been marked as included, click the Create Experiment 

button from the FMI ribbon tab.  This generates a new sheet with the prefix “Exp”.  In this case 

the sheet name is “Exp Tests.DriveCycleVTM”.   The sheet has four areas, "Model", "Settings", 

"Indata" and "Outdata". The Indata and Outdata areas were generated based on the variables in the 

Load FMU sheet with their Include value set to TRUE and their corresponding Experiment 

selections. The number of simulation cases is defined by columns called "Case 1", "Case 2", etc. 

Three cases are generated by default, and more can be added by inserting columns.  To ensure that 

the ranges in the Excel sheet are maintained properly, select any cell in a column corresponding to 

a simulation case except “Case 1”.  
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Figure 20  FMIE experiment sheet 

6) This experiment will test the effects of the vehicle final drive ratio on the vehicle fuel economy 

during a UDDS drive cycle test. 

a. The UDDS cycle is number 19 (refer to the Drive Cycle Key.pdf document for a list of 

predefined cycles and their profiles).  Change the driveCycleNameIndex default value 

from 2 to 19.   

b. Since the duration of the UDDS cycle is approximately 1370 seconds, increase the Stop 

time in the Default column to 1400.  Also, to capture a reasonable resolution of the results 

increase the Output points in the Default column to 2800.  This value will capture data at 

½ second intervals. 

c. Next, to test the effects of varying the final drive ratio, enter the values 3, 4, and 5 for the 

rear_ratio parameter for cases 1, 2, and 3 respectively.  Note that the default value of a 

parameter is overwritten by entering values in a case column. 

d. Finally enable result trajectory creation by checking the Show Results and Create 

Results checkboxes on the FMI ribbon tab.  By default these fields are unchecked and 

only the final value of output data is returned to the workbook.  When these fields are 

checked, the full time trajectory (at the selected output interval rate) is returned in a new 

sheet with the prefix “Res”. 

e. The final experiment sheet should look similar to the following: 
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Figure 21  FMIE fully specified experiment sheet 

This experiment sheet will run 3 separate simulations of the UDDS cycle with final drive 

ratios of 3:1, 4:1, and 5:1 respectively. 

7) Now that the experiment sheet is created and ready, click the Initialize FMU button on the FMI 

ribbon tab.  If successful, the worksheet should now show the initial values for each of the output 

data variables and the Message row should show OK. 
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Figure 22  FMIE initialized experiment sheet 

8) If the initialization of the FMU was successful, click the Simulate FMU button from the FMI 

ribbon tab.  This step will launch each case in parallel on a separate processor, up to the number of 

processors on the machine and the Number of processes specified on the experiment sheet.  Note 

that this simulation is fairly long and dynamic.  It can take a few minutes (~10 minutes) to 

complete. 

9) When the simulation completes, the final values of each output variable are returned to the 

experiment sheet. 
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Figure 23  FMIE completed simulation experiment sheet 

In this case, the final fuel economy metrics show that the case with the 3:1 final drive ratio was 

slightly better than the case with the 4:1 ratio. 

10) Also, when the simulation completes, a new worksheet will be created with the prefix “Res”.  In 

this case, it is something similar to Res Tests.DriveCycleVTM.  The structure of this sheet is 

columns of output data with time in the first column and variable trajectories in subsequent 

columns for each simulated case.  Any cases that were disabled on the experiment sheet or failed 

simulations will contain empty columns.  For this experiment sheet, the result sheet should look 

similar to the following if the simulations completed successfully: 
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Figure 24  FMIE result sheet 

11) With the variable time trajectories returned to the result sheet, any standard Excel® routine can be 

used to review the results. 

a. Plot the vehicle velocity for each case by selecting the corresponding time and velocity 

(column summary.v_x) for each case and adding to a scatter plot chart. 

 

Figure 25  FMIE vehicle velocity comparison figure 
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b. Next plot the engine speed from the column labeled summary.mpg: 

 

Figure 26  FMIE fuel economy metric comparison figure 

c. Other interesting trajectories are the engine speed (summary.engine_w), coolant 

temperature (summary.coolant_T) and thermostat positions 

(summary.coolant_thermostat_s) shown below. 

 

Figure 27  FMIE engine speed comparison figure 
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Figure 28  FMIE engine coolant temperature comparison figure 

 

Figure 29  FMIE engine thermostat comparison figure 

12) The last example in this section shows how to apply a time varying input to an FMU.  To start use 

the process in step 2 to load the VTMModels_DriveCycleVTM_0withInputs.fmu from the 

FMUs\CS folder.  The model used to create this FMU is identical to the model shown in Figure 

1except that the throttle and brake signals are no longer generated by the internal driver model but 

will be set as time trajectory inputs from Excel®. 

13) When the FMU is loaded, use the list filter from the Name column to search for and include the 

desired variables. 

a.  From the top level throttlePosition input variable.  This variable will be named 

throttlePosition without any additional levels of hierarchy.  Toggle the Include field to 

TRUE. 



27 
 

 

 

Figure 30  FMIE top level throttle pedal position input 

Do the same for the brakeForce input variable. 

 

Figure 31  FMIE top level brake pedal force input 

b. Use the Name list filter to search for “driver.summary”.  Then choose the summary_s_acc 

and summary_f_brk output variables as shown. 

 

Figure 32  FMIE throttle pedal position and brake force output variables 

c. Next use the steps from section 4)c above to select the summary record output variables. 

The final list of variables should appear similar to the following: 

 

Figure 33  FMIE included variable list 
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14) Next click the Create Experiment button to create the experiment sheet.  A new worksheet will 

be created with a name similar to Exp DriveCycleVTM_withInputs. 

15) In this test, cases 2 and 3 will be disabled by toggling the Enable flag to FALSE as shown. 

 

Figure 34 Experiment sheet for the input trajectories 

Also set the stop time and number of output points as desired.  In this example, simulating for 100 

seconds with 200 output points is reasonable. 

16) Now the input throttle and brake trajectories can be defined. 

a. On a separate worksheet, define the throttle position and brake force time trajectory arrays 

with time in the first row (or column) and the data in the second row (or column).  The 

input trajectory range must have dimensions either 2 x M or M x 2, where M is the 

number of data points. The first row or column must contain the time points and the 

second row or column must contain the data values. For 2 x 2 sets, the time points are in 

the first row.  In this example the following two trajectories were defined as shown in the 

following figure. 
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Figure 35  Throttle pedal position and brake pedal force array specification 

b. Use the mouse to select the cell for the throttlePosition input variable for Case 1 on the 

experiment sheet.  In Figure 34 this cell is F21. 

c. Start typing an equal sign (=) in the selected cell as shown. 

 

Figure 36  FMIE array formula entry 

d. Next select the throttle position trajectory array as shown. 
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Figure 37  FMIE array formula selection 

e. Finally click Ctrl + Shift + Enter to create an array formula. If successful, the first 

value in the input trajectory range will be visible in the cell, in this case 0. Otherwise 

"#VALUE!" will be displayed in the cell.  The formula bar should show an array formula 

similar to {=Sheet2!B1:M2}. 

f. Repeat steps b – e above for the brakeForce input variable.   

17) Finally click Simulate FMU from the FMI ribbon tab to run the simulation.  This action will run 

the single test Case 1.  The final values of the output variables are returned to the experiment sheet 

and also create the new result sheet with a name similar to Res DriveCycleVTM_witInputs.  

Some trajectories from the result sheet to observe are the throttle 

(mechanicalElectrical.driverVehicle.driver.summary_s_acc) and brake 

(mechanicalElectrical.driverVehicle.driver.summary_f_brk) commands, the vehicle speed 

(summary.v_x) and the engine speed (summary.engine_w). 
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Figure 38  FMIE throttle pedal position figure 

 

Figure 39  FMIE brake pedal force figure 
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Figure 40  FMIE vehicle speed figure 

 

Figure 41  FMIE engine speed figure 

The FMI Add-in User’s Guide contains a number of different examples of FMI-based workflows with 

Excel, including a scripting API for automated simulation and analysis.  All FMIE demos can be run even 

after the evaluation license has expired.  

FMU workflows in MATLAB/Simulink using FMI Toolbox 
This tutorial illustrates sample FMI-based workflows in MATLAB/Simulink with FMI Toolbox for 

MATLAB from Modelon.   
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DemonstrDemonstrDemonstrDemonstration: ation: ation: ation: FMU import in Simulink FMU import in Simulink FMU import in Simulink FMU import in Simulink (optional hands(optional hands(optional hands(optional hands----on)on)on)on)    

This tutorial shows the import of FMUs into MATLAB/Simulink using FMI Toolbox for 

MATLAB/Simulink (FMIT).  Integration of FMUs with Simulink models supports FMI-based workflows 

for controls development or when Simulink is used as an integration platform.  FMI Toolbox can 

optionally also export FMUs from Simulink models for integration into other FMI-compliant tools.  

Bidirectional integration with Simulink will be illustrated in this tutorial. 

1) Preparation: Install FMI Toolbox via installer FMI Toolbox-1.8.5-win.exe accepting all defaults. 

The demo license for FMIT is in the Licenses folder and should be placed in the AppData folder 

as described in the FMIT User’s Guide (i.e. 

C:\Users\username\AppData\Roaming\Modelon\Licenses\Nodelocked). In MATLAB, change 

current directory to the FMI Toolbox installation directory (default: C:\Program Files 

(x86)\Modelon\FMI Toolbox 1.8.5) and run the ”setup” function. See Section 3.3 of the FMIT 

User’s Guide for more details.   

2) Launch MATLAB. 

3) Open the Simulink Library Browser and look for the FMI library (see figure below). The FMI 

library contains blocks for importing both co-simulation & model exchange FMUs. 

 
4) Drag the co-simulation (CS) block into a new Simulink model. 
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5) Double-click on the CS block to load the “VTMModels_DriveCycleVTM_0withInputs.fmu” as 

shown below. 

 
6) Once loaded, the toolbox populates the parameters of the model and the corresponding start 

values. The other tabs provide additional information/options about the outputs, model data etc. 

7) Click on Close in the FMI dialog to load the model. This step loads the FMU in Simulink with the 

appropriate inputs and the (default) outputs set in the original tool that exported the FMU. 

 
8) In this experiment, we will vary the throttle position and brake force and observe the engine 

torque (engine_tau) and vehicle velocity (vehicle_v). 

9) In the FMU dialog, remove all other outputs except for engine_tau and vehicle_v. 
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Note: The user is also allowed to add additional output signals to the FMU through the Add Scalar and 

Add Vector buttons. Adding outputs is done by navigating the variable tree on the left, choosing the 

variable to be added, and then clicking on the appropriate Add button. 

 

 
10) Add a signal builder from the Simulink sources library. Create 2 custom signals with the 

following time traces and name these as Throttle Positon and Brake Force respectively. 

Time 0 1 3 6 20 23 25 30 40 42 50 52 55 60 

Throttle 

Position 
0 0 0.1 0.5 0.5 0.35 0.3 0.3 0.5 0.5 0.15 0.05 0 0 

Brake 

Force 
0 0 0 0 0 50 200 50 0 0 150 150 200 200 
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11) Connect these signals to the corresponding inputs to the FMU. Add a scope and connect the 

engine_tau and vehicle_v outputs to the scope as shown. 

12) Simulate the model for 60 seconds and observe the scope.  

 
 

13) Now, the Simulink solver (Master) and the solver embedded within the FMU (slave) 

communicate at the default 0.1 sec interval. This setting can be found in the Advanced tab in the 

FMU dialog. 
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14) Change this sampling interval to 5 sec and simulate the model to 60 sec and observe the difference 

in the trajectory of the outputs compared to the previous experiment. 

15) Do you notice a difference in the trajectories of the outputs between the two experiments? Why? 

The communication between the master and slave algorithm introduces a zero-order hold of the inputs 

sampled at the communication time interval. The sampling is noticeable in the output behavior in Step 

13. 
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16) In the next experiment, let us change the mass of the vehicle. Double click on the fmu and filter 

out all variables with the string mass. 

 
17) Set the mass to 1000 kg. Once the parameter is changed from the default, notice a small asterisk 

appearing next to the parameter name in the dialog. 
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Note: The parameter values can be restored to the default values individually or en masse with the 

Reset Value and Reset All Values buttons. 

18) Reset the communication interval to 0.1 sec in the Advanced tab and simulate the model. Observe 

the trajectories of the outputs and compare these with the previous experiment. 

 
 

The following figure plots the engine torque & vehicle speed for the simulation cases with vehicle 

mass 1600 kg (black) and 1000 kg (magenta) 
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Demonstration: Demonstration: Demonstration: Demonstration: FMU export from Simulink using the FMI ToolboxFMU export from Simulink using the FMI ToolboxFMU export from Simulink using the FMI ToolboxFMU export from Simulink using the FMI Toolbox    

FMI Toolbox includes an optional Coder feature to export Simulink models as FMUs for import into other 

FMI-compliant tools.  This feature requires MATLAB/Simulink and Simulink Coder.  Attendees with 

Simulink Coder can follow the instructions in Chapter 5 of the FMIT User’s Guide to create a simple 

model and export it as an FMU.  The FMU can then be imported into other FMI compliant tools as 

documented in this tutorial. 

The FMI Toolbox User’s Guide contains a number of different examples of FMI-based workflows 

including Design of Experiments, execution of FMUs in MATLAB scripts, and integration of FMUs with 

other MATLAB toolboxes.  All FMIT demos can be run even after the evaluation license has expired.  

 


